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INTRODUCTION

Dell™ 3-2-1 Reference Configurations help companies by simplifying
the design, ordering, and deployment of a virtualized infrastructure.
Choosing a proven architecture designed by Dell to meet your needs
allows you to confidently deploy an optimal solution without the time
requirement and hassle of compiling your hardware solution
piecemeal. You also get to reap the benefits of Dell’s best practice

recommendations and guidelines.

In this guide, we take a look at the pieces Dell provides you to create
a highly available virtualized infrastructure and take you step by step

through the process of setting it up. Dell 3-2-1 Reference

gﬁsglrePoint' Configurations follow the 3-2-1 model, which means the
configuration is comprised of three servers, two switches, and one
E’ storage array. Our virtualized architecture consists of two Dell
SQL Server Et)r(o?l[wange

PowerEdge™ R515 servers with AMD Opteron™ 4184 processors as
host servers, one Dell PowerEdge R415 server as a management
server, two Dell PowerConnect™ 6248 switches, and one Dell
EqualLogic® PS4000XV storage array. We add the software you need
to help manage your business, including Dell OpenManage, and from
Microsoft®, Windows Server® 2008 R2 SP1, Exchange Server 2010,
SQL Server® 2008 R2, SharePoint Server® 2010, and System Center
Essentials 2010.

We show you how to combine these components into a robust
infrastructure with the power to support over 500 users. For our

performance testing of this solution, see our companion performance

report.
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Features of the new Dell PowerEdge R515

Figure 1: The new Dell PowerEdge R515 server.

The Dell PowerEdge R515 with AMD Opteron 4184 processors offers
many new features for maximizing performance and for minimizing

operational expenses, including the following:

e Power. The Dell PowerEdge R515 includes enhancements that
let it use less energy than many older servers do, so your
potential power savings are dramatic.

e Processors. AMD Opteron 4100 Series processors power the
Dell PowerEdge R515, making it an excellent yet affordable
platform.

e Management. The Dell PowerEdge R515, like all late-model
Dell servers, comes with the Dell Lifecycle Controller. This tool
simplifies server management by providing a single interface
for management functions and by storing critical system
information in the system itself. There are no CDs or USB keys
to keep track of for drivers or firmware.

e Storage. The Dell PowerEdge R515, available in both an 8-bay
and 12-bay chassis, holds up to 25 terabytes of internal
storage, many times the capacity of prior common small
business servers.

e Memory. The Dell PowerEdge R515 holds up to 128 GB of
RAM, many times the RAM capacity of older small business
servers, allowing for powerful flexibility with virtualized
database solutions.

About Dell OpenManage
Dell server configurations come equipped with Dell OpenManage

software, which brings together network and systems management
applications built using industry-standard specifications. Dell

OpenManage operates seamlessly with systems management

Dell 3-2-1 Reference Configurations: High-availability A Principled Technologies configuration guide 5
virtualization with Dell PowerEdge R515 servers



consoles like Microsoft Systems Center Essentials to bring you all the

tools you need to manage your infrastructure in one place.

About Microsoft Windows Server 2008 R2 SP1
Windows Server 2008 R2 SP1, the latest release of this server OS from

Microsoft, includes many features that benefit your business,

including the following:

e Virtualization. Microsoft Windows Server 2008 R2 comes with
Microsoft Hyper-V, which you can use to create virtual
machines. These virtual servers, which are often more
powerful than your previous physical machines, can host your
critical business applications and databases. Virtual machines,
while allowing you to isolate business functions for security or
regulatory reasons, are the backbone of high-availability in
that they can be easily migrated from one server node to
another node in a failover cluster when needed.

o Simplified installation. The wizard-based setups of Windows
Server 2008 R2 and SQL Server 2008 R2 make the installation
and configuration process considerably simpler than in past
versions.

e Windows Management and updated components. Microsoft
Windows Server 2008 R2 includes a revamped Server
Manager console that contains almost all server management
functions, including the ability to quickly add Roles and
Features to your server.

About Microsoft SQL Server 2008 R2
SQL Server 2008 R2 is the latest release of Microsoft’s database

management platform. As with each release, Microsoft has added
new features to expand on the capabilities of their Database
Management System (DBMS) platform. Where earlier versions of SQL
Server required database administrators to rely primarily on either in-
house applications or third-party tools to monitor multiple instances,

SQL Server 2008 R2 simplifies multi-server management.
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About Microsoft Exchange Server 2010 SP1
Microsoft Exchange Server 2010 SP1 equips you with a robust

communications platform that can also give your users anywhere
access, increasing their mobility. Some other key features of
Exchange Server 2010 include Unified Mailbox Resiliency, archiving,

and access to the Outlook Web Application.

About Microsoft SharePoint Server 2010
Microsoft SharePoint Server 2010 is the latest version of this very

popular and flexible software. It allows users to create collaborative
Web sites and to create and manage their own workspaces. Some of
its key features include SharePoint 2010 Communities, which lets
users share ideas and information from a single platform; the
SharePoint Search feature, which lets users find other people and
information quickly; and SharePoint 2010 Insights, which gives users
an improved ability to access databases, reports, and business

applications.

About Microsoft System Center Essentials 2010
Microsoft System Center Essentials (SCE) 2010 software, which now

includes System Center Virtual Machine Manager (SCVMM) 2008 R2
technology, provides you with a centralized management solution
from which you can configure, maintain, modify, and monitor the
physical and virtualized servers in your infrastructure. Dell PRO-Pack
(Performance and Resource Optimization Pack), when used in
conjunction with SCE 2010, helps provide simplified, proactive
management for physical and virtual servers, through such actions as
alerting SCVMM of the need for live migration of VMs to another

server in the cluster. With SCE 2010 and Dell PRO-Pack, it is easier
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than ever to monitor your configuration and quickly address any

issues that should arise.

WE SHOW YOU HOW - SETTING UP YOUR DELL 3-2-1 REFERENCE

For this Guide, we assume that you have an existing infrastructure

server running Active Directory Domain Services (AD DS), Domain

Name Services (DNS), and Active Directory Certificate Services.

Figure 2 shows the hardware that comprises the Dell 3-2-1 Reference

Configuration we tested, along with the function of each piece.

Name

Function

Dell PowerEdge R515

Host servers

Dell PowerEdge R415

Management server

Dell PowerConnect 6248

Switches

Dell EqualLogic PS4000XV

Storage array

Figure 2: The hardware that comes with the Dell 3-2-1 Reference Configuration we

Our Dell 3-2-1 Reference Configuration had the following software

e Microsoft Windows Server 2008 R2 SP1 Enterprise Edition (x

e Dell Host Integration Tools (HIT)

e Dell OpenManage Server Administrator 6.4 (OMSA)
e Microsoft Systems Center Essentials 2010

e Microsoft Exchange Server 2010 SP1

e Microsoft SQL Server 2008 R2

e Microsoft SharePoint Server 2010

e Broadcom® Advanced Control Suite (BACS)

CONFIGURATION
Quantity
2
1
2
1
tested.
requirements:
6)
Cabling

For our high-availability setup, we configured the network cabling of

the hardware as shown in Figure 3.
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Dell PowerEdge R515 Dell PowerEdge R515

Dell PowerConnect 6248

-8 Public + VM network
iSCSI network

-8 Live Migration network

-® Private/CSV network

; ¥ Dell PowerEdge R415 -8 Stacking connections

_-t To existing infrastructure

W N

Figure 3: Networking cabling for our Dell 3-2-1 Reference Configuration.

To take advantage of the features of the Dell PowerConnect 6248
switches, we implemented the stacking feature to allow connectivity
between the switches. This feature lets you easily manage the two
switches from a single management console and allows for greater

bandwidth than you would have using link aggregation.

Figure 4 shows how we configured the network cables across the NICs

for each Dell PowerEdge R515.

Port
NI Traffi
£ number raffic type
1 Public/VM #1
Int ted on-board NIC
ntegrated on-boar 2 Private/CSV
1 iSCSI #1
Broadcom NetXtreme Il 5709 #1 ! ; : :
2 Live Migration
1 iSCSI #2
B 2
roadcom NetXtreme I 5709 # > Public/VM #2

Figure 4: NIC port configurations for each Dell PowerEdge R515.
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Once we connected all of the network cables, we attached all power

cables. At this point, it was safe to power on all of the hardware.

Setting up the switches

By default, the Dell PowerConnect 6248 switches are configured with
a blank password, have the IP address 192.168.2.1, and have the
subnet mask 255.255.255.0. We used a serial connection to access
the basic setup wizard on the switches, allowing us to easily configure
an administrator password and change the IP address to match our IP
scheme. Figure 5 provides details on our IP scheme. For more
information on configuring the many features of the Dell
PowerConnect 6248, visit

http://support.dell.com/support/edocs/network/pc62xx/en/index.htm.

Subnet Traffic type Adapters assigned to this subnet

iSCSI adapters(for this setup, there are

192.10.1.0 | iSCSI
four)

Management server, storage
management, public/VM host server,
infrastructure server, and iDRAC
management

192.20.1.0 | Public/VM

Private/CSV adapters (for this setup,

192.30.1.0 | Private/ CSV
there are two)

Live Live Migration adapters (for this setup,

192.40.1.0
Migration there are two)

Figure 5: The IP scheme we used.

Setting up the shared storage and networking
In this section, we discuss setting up the Dell PowerEdge R515s with
the Dell EqualLogic PS4000XV storage array and isolating the various

types of switch traffic using VLANs. For more details, see Appendix A.

Perform these steps on the first Dell PowerEdge R515, which will

become the first Hyper-V host:
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1. Using Server Manager, install the Hyper-V role and add the
Failover Clustering feature. You will need to restart the server
after installing the Hyper-V role.

During our installation of this role on both Hyper-V host
NOTE servers, we did not create a virtual network. We did this later
in Systems Center Essentials when we created the virtual

machines to avoid accidentally creating multiple virtual
networks.

2. Install the Dell EqualLogic Host Integration Tools (HIT)
software provided with the PS4000XV.

3. Open the Dell EqualLogic Remote Setup Wizard provided with
the HIT software to initialize the PS4000XV, set the basic
storage group IP address, and create an administrator
username and password.

4. Gointothe Network and Sharing Center, and apply the
appropriate IP address and label to each NIC.

5. Open the Dell EqualLogic Remote Setup Wizard to modify the
MPIO settings, and limit iSCSI traffic to the iSCSI IP subnet you
selected.

6. Change the name of your server to an appropriate name and
join the domain. In our case, we selected Hypervhost1 for the
server name and test.local for our domain. Joining the domain
modifies the IQN name of your Hyper-V host server. We
performed this step to avoid having to change the iSCSI access
settings of the Dell EqualLogic PS4000XV storage later. After
completing this step, reboot the server and log into the
domain.

If you are unable to establish contact with the domain
NOTE controller, you may need to modify the Windows Firewall
settings on the Hyper-V host servers.

7. Open a Web browser window, and enter the IP address of the
storage group. Once you have provided the credentials you set
up in Step 2, complete the following steps in the console:

a. Apply the IP address of the second iSCSI connection and
enable it.

b. Apply the IP address of the management port and enable
it.
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c. Create nine volumes, one for each type of data that will be
hosted on the servers, virtual machine operating systems,
as well as a disk witness volume for the failover cluster,
allocating an adequate size to meet your needs. Figure 6
shows the volume sizes that we selected during this setup
process. For the virtual machine operating system and disk
witness volumes, restrict access based on the iSCSI
initiator name and enter the IQN of the first Hyper-V host
server. Leave the default selection for no access to the
remaining volumes created. Be sure to allow multiple
simultaneous connections for all volumes. Later in setup,
when the virtual machines are running, we will add access
to the SharePoint, Exchange, and SQL Server volumes to
match their respective virtual machine IQN.

Volume Name Volume size (GB)
VirtualMachinel 70
VirtualMachine2 70
VirtualMachine3 70
SharePoint 500
Exchange 500
Exchangelog 125
SQLData 500
SQlLog 125
DiskWitness 10

Figure 6: The volumes we created on the Dell EqualLogic PS4000XV.

Once you have completed basic setup on the second Hyper-V
host, you will need to return to this console to grant access to

NOTE the virtual machine operating system and disk witness
volumes by adding the iSCSI initiator name of the second host.
We will remind you to do this later.

8. Open iSCSI Initiator in Administrative Tools, add the IP address
of the storage under Discovery, and establish connections to
each of the virtual machine operating system and disk witness
volumes. Ensure that the target is added to the favorite
targets and that multi-path is enabled so that the Hyper-V
host automatically establishes connections with the storage.

9. Open Disk Management and bring each of the volumes online.
Perform a quick format and assign drive letters.
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10. Install Broadcom Advanced Control Suite (BACS) and create a
NIC team with failover and load balancing on the two
Public/VM network NICs.

11. Assign an IP address to the teamed NIC. The two Public/VM
network NICs no longer have individual IP addresses and
instead are accessed using the single teamed NIC IP address.

Now that the first Hyper-V host is configured, complete these steps
on the other Dell PowerEdge R515, which will become the second

Hyper-V host server:

1. Using Server Manager, install the Hyper-V role and add the
Failover Clustering feature. Restart the server after installing
the Hyper-V role.

2. |Install the Dell EquallLogic Host Integration Tools software
provided with the PS4000XV.

3. Navigate to the Network and Sharing Center, and apply the
appropriate IP address and label to each NIC.

4. Open the Dell EqualLogic Remote Setup Wizard to modify the
MPIO settings, and limit iSCSI traffic to the iSCSI IP subnet you
selected.

5. Change the name of your server to an appropriate name and
join the domain. In our case, we selected Hypervhost2 for the
server name. After completing this step, reboot the server,
and log into the domain.

6. Open a Web browser window and enter the IP address of the
Dell EqualLogic PS4000XV storage group. Provide the
adequate credentials, and modify the access settings for each
of the virtual machine and disk witness volumes by adding the
iSCSI initiator name of this secondary Hyper-V host. This
allows the host to connect to the Dell EqualLogic PS4000XV
storage in iSCSI Initiator.

7. In Administrative Tools, open iSCSI Initiator, add the IP
address of the storage under Discovery, and establish
connections to each of the target volumes. Ensure that the
target is added to the favorite targets and that multi-path is
enabled so that the Hyper-V host automatically establishes
connections with the storage.
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8. Open Disk Management, and verify that the volumes are

visible in Windows and that they are online.

Install Broadcom Advanced Control Suite (BACS) and create a
NIC team with failover and load balancing on the two
Public/VM network NICs using the same name as the first
Hyper-V host.

10. Assign an IP address to the teamed NIC. The two Public/VM

network NICs no longer have individual IP addresses and
instead are accessed using the single teamed NIC IP address.

Now, we will use the management server (in our case, the Dell

PowerEdge R415) to access the Dell PowerConnect 6248 switches and

create the VLANSs to isolate the different types of traffic. Perform the

following steps on the management server:

In the Network and Sharing Center, apply an IP address to the
management server.

Change the name of your server to an appropriate name and
join the domain. For the name, we selected Mgmt-Server.
Reboot the server, and log into the domain.

Open a Web browser window, enter the IP address of the
switches, and enter the appropriate administrator credentials

when prompted.

4. Using the Web console, create three VLANSs. Figure 7 shows
the VLAN ID and type of traffic assigned to each VLAN.

5. Assign the appropriate ports on each switch unit to each

VLAN.
VLAN ID | Traffic type Ports assigned to this VLAN
. iSCSI traffic ports from storage and

10 iSCSI .
servers (for this setup, there are four)

30 Private/ CSV Private/CSV ports (for this setup,
there are two)

40 Live Migration Live Migration ports (for this setup,
there are two)

Figure 7: Sample VLAN configuration.
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We recommend that you follow Dell best practices for switch ports
that handle iSCSI traffic. For more information, see the latest edition
of the Dell EqualLogic Configuration Guide at

http://www.delltechcenter.com/page/EqualLogic+Configuration+Gui

de.

Preparing the failover cluster and configuring the management server

Next, we will prepare the Hyper-V hosts for failover clustering and

configure the management server. For more details, see Appendix B.

First, perform the following steps on both of the Hyper-V host

servers:

1. Reboot the server and verify that virtualization is enabled on
the AMD Opteron 4184 processors in the BIOS.

2. During the boot process, access the iDRAC utility and
configure the IP settings. In our setup, we selected an IP
address that can be accessed from the management server.

3. Install Dell OpenManage Server Administrator.
You may need to create a self-signed certificate to be able to
NOTE configure the HTTPS listener and install the Remote
Enablement feature. See the user’s guide for more
information at

http://support.dell.com/support/edocs/software/svradmin/6.
4/en/index.htm

4. Install the Failover Clustering feature using Server Manager.

Next, complete the following steps on only one of the Hyper-V host

servers:

1. Inthe Failover Clustering feature in Server Manager, run the
Validate a Configuration Wizard. You need to add both Hyper-
V host servers into the wizard when it prompts you, and run
all tests to ensure that your hardware is set up correctly. Once
you have verified that all tests have passed, continue with the
next step. For more information on failover cluster validation
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and requirements, go to http://technet.microsoft.com/en-
us/library/cc772055.aspx.

2. Create a failover cluster with both Hyper-V hosts and assign an
appropriate NIC and IP address for the public cluster network.

3. Enable Cluster Shared Volumes, verify that the cluster is using
the correct disk witness you created for quorum, and add the
other three volumes as cluster shared volumes.

4. Configure the networks for cluster access and ensure that
iSCSI NICs are not configured for cluster network
communication. Be sure to note which cluster network has
the subnet corresponding with your Private/CSV network, as
you will need this to complete the next step.

5. Designate the Private/CSV network as the preferred network
for CSV communication using the Metric property. For more
information on this property, see
http://technet.microsoft.com/en-
us/library/ff182335(WS.10).aspx

Next, complete these steps on the management server:

1. Reboot the server, access the iDRAC utility, and configure the
IP settings.

2. |Install Dell OpenManage Server Administrator.
You might need to create a self-signed certificate to be able to
NOTE configure the HTTPS listener and install the Remote
Enablement feature.
3. Using Server Manager in Remote Server Administration Tools,
add the following features:
a. Under Role Administration Tools, add Hyper-V Tools.

b. Under Feature Administration Tools, add Failover
Clustering Tools.

4. In Administrative Tools, go to Hyper-V Manager, and connect
to both of the Hyper-V host servers to verify that the
management server can access the host servers.

5. Install Systems Center Essentials (SCE) 2010 with all available
features, and unless you have an existing server in your
infrastructure with SQL, choose to install SQL Express during
the Systems Center installation process.
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6.

Creating the virtual machines
Creatin

When the installation has completed, run the SCE 2010
console and complete the configuration wizard. During the
wizard, you may elect to automatically discover unmanaged
servers or run the discovery wizard afterwards and add the
Hyper-V host servers.

Wait for SCE 2010 to install the management agents onto both
Hyper-V host servers, and then add one of the Hyper-V host
servers using the Designate a Host for Virtual Machines
wizard. The wizard will automatically detect the failover
cluster and will also designate the second node (the other
Hyper-V host server) as a host. When configuring the network,
create a virtual network on the BASP adapter, which is your
Teamed NIC, and select Do Not Configure for all other network
adapters.

Finally, download and import the Dell PRO enabled
Management Pack 2.0 into SCE 2010 from
http://support.us.dell.com/support/downloads/download.asp
x?2c=us&cs=555&|=en&s=biz&releaseid=R252410&formatcnt=
1&libid=0&typeid=-1&dateid=-1&formatid=-1&fileid=369241.

g virtual machines (VMs) is easy using Systems Center

Essentials 2010. Use the steps below to create the three VMs you will

need for your virtualized environment. For more details, see

Appendix C.

1.

In the Computers section of the SCE console, use the New
Virtual Machine wizard to create the VM as follows:

a. Select an appropriate virtual hardware template, and
make any necessary customizations.

b. Select Install from the DVD, and insert your copy of
Windows Server 2008 R2 SP1 Enterprise Edition into the
drive of the host you will select in the next step.

c. Select one of the two Hyper-V host servers, assign a
name to the VM, select the appropriate volume, and

create the VM.

2. Use the Configure Virtual Machine wizard to install the
operating system and perform discovery to add it to
management. Note that before discovery can succeed, you
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need to go into the VM, assign an adequate name and IP
address, and join it to the domain.

3. Repeat this procedure twice to create the other two VM,
distributing the VMs so that two are on one Hyper-V host
server, and one is on the other Hyper-V host server.

Verify that you do not have the host DVD/CD drive attached to
NOTE more than one virtual machine, or you may experience errors
when attempting to start your VMs.

4. Using the Failover Cluster Manager, configure the priority of
the networks for Live Migration so that the dedicated Live
Migration NIC is the preferred network and ensuring that the
iSCSI NICS are not used for Live Migration.

5. Using the Hyper-V Manager, create an external virtual
network on each of the two iSCSI adapters on each Hyper-V
host server, allowing for the management operating system to
share the adapter. Be sure to use identical names for the two
virtual networks across the two Hyper-V host nodes.

6. You will need to shut down all VMs to complete this step.
Using the Hyper-V Manager, go into the settings for each VMM,
create two virtual network adapters, and attach each to one
of the virtual networks you created in the previous step.

7. Finally, boot up the VMs and assign IP addresses to the newly
created virtual network adapters using your iSCSI network IP
scheme.

Customizing your virtual machines
In this final section, we discuss adding additional storage volumes to

the VMs, and installing SQL Server 2008 R2, Exchange Server 2010
SP1, and SharePoint Server 2010 on the VMs.

Adding storage volumes to the virtual machines

Follow the steps below to attach the storage volumes you created on

the Dell EqualLogic PS4000XV earlier to each of the virtual machines.

1. Install the Dell Equallogic Host Integration Tools software on
the VM.

2. Open a Web browser window, and enter the IP address of the
storage group. Once you have provided the appropriate
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credentials, modify the access settings for the appropriate
volumes by adding the iSCSI initiator name of the VM. For
example, for VM #1, which will serve as the SQL Server VM,
you will modify the SQLData and SQLLog volumes’ access
settings by adding the iSCSI initiator name of VM #1 and so on.

3. OpeniSCSI Initiator, add the IP address of the storage under
Discovery, and establish connections to the appropriate target
volumes. Ensure that the target is added to the favorite
targets and that multi-path is enabled so that the VM
automatically establishes connections with the storage.

4. Open Disk Management and bring each of the volumes online.
Perform a quick format and assign drive letters.

Installing SQL Server 2008 R2 on VM #1

After you create your virtual machines, you must install SQL Server
2008 R2 on VM #1. Although it is not required, you should, when
possible, deploy SQL Server 2008 R2 on machines that are part of an
Active Directory® domain. If you do choose to deploy SQL Server in a
domain, do not make the SQL Server service domain accounts
members of the Domain Administrators group. In fact, grant only the
necessary rights on the local server to the SQL Server service account
as part of your pre-installation planning. The SQL Server installation

software creates the local groups it needs for its security purposes.

This section provides an overview of the SQL Server 2008 R2
installation process. Appendix D provides detailed installation

instructions.

1. Insert the SQL Server 2008 R2 DVD into the host machine DVD
drive, mount it to the virtual machine, and log into the virtual
machine. If prompted to enable the .NET Framework Core
role, click OK.

2. On the Installation Center screens, choose Installation, and
choose to proceed with a new installation. (See Figure 8.)
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% SQL Server Installation Center E o ] S
Planning Hardware and Software Requirements I
View the hardware and software requirements,

Installation the hard d saft
Maintenance = Seaurity Documentation
Tools View the security documentation.
Resources = Online Release Notes
Advanced View the latest information about the release.
Options Setup Documentation
Read the Overview of SQL Server Setup Documentation topic for information about SQL Server
Books Online. The Setup documentation indudes an overview of SQL Server installation, the
help topics that are needed during installation, and links to more detailed information about
planning, instaling, and configuring SQL Server.
p.f System Configuration Checker
Lf Launch a tool to check for conditions that prevent a successful SQL Server installation,
& Install Upgrade Advisor
L} Uparade Advisor analyzes any SQL Server 2005 or SQL Server 2000 components that are
installed and identifies issues to fix either before or after you upgrade to SQL Server 2008 R2,
Online Installation Help
Launch the online installation documentation.
e How to Get Started with SQL Server 2008 R2 Fallover Clustering
Read instructions on how to get started with SQL Server 2008 R2 failover dustering,
How to Get Started with a PowerPivot for SharePoint Standalone Server Installation
Read instructions on how to install PowerPivot for SharePaint in the fewest possible steps on a
new SharePoint 2010 server,
T e Upgrade Documentation
£ SQL SEFVEF'ZGOS RZ View the document about how to upgrade to SQL Server 2008 R2 from SQL Server 2000, SQL
. Server 2005 or SOL Server 2008, ;I

Figure 8: SQL Server 2008 R2 Installation Center options.

3. Proceed through the first several installation steps, entering
license information, and installing prerequisites with default
options specified. On the Setup Role screen, choose a SQL
Server Feature Installation.

4. On the Feature Selection screen, select only what you need
for your particular configuration (see Figure 9). In our case, we
chose the Database Engine Services and Management Tools.
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1 SQL Server 2008 R2 Setup

Feature Selection

Select the Standard features to install.

=1oix|

Setup Support Rules

Setup Role

Feature Selection
Installation Rules

Instance Configuration

Disk Space Requirements
Server Configuration
Database Engine Configuration
Error Reporting

Installation Configuration Rules
Ready to Instal

Installation Progress

Complete

Features:

Description:

Instance Features
Database Engine Services
[]sqL server Replication
[ Full-Text Search
[] analysis Services
I:l Reporting Services
Shared Features
[ Business Inteligence Development Studio
Client Tools Connectivity
D Integration Services
Client Tools Backwards Compatibility
[ client Tools DK
[[] 5L server Books Online
Management Tools - Basic
Management Tools - Complete
D SQL Client Connectivity SDK
[ Microsaft Sync Framework
Redistributable Features

Server features are instance-
aware and have their own
registry hives, They support
multiple instances on a computer.

Select All | Unselect All |
Shared feature directory: IC: ‘\Program Files\Microsoft SQL Servery
Shared feature directory (x86): |C:\Frogram Files (x86)WMicrosoft SQL Server,
< Back Cancel | Help |
P

Figure 9: Choosing features for installation.

5. On the first installation, choose to install the default instance.
If you perform subsequent installations on the same server,
choose named instance and provide a name for the instance.

6. Configure the credentials of the SQL Server service account
and SQL Server Agent accounts.

7. Specify SQL Server administrators, and specify the
authentication mode desired for your configuration. Microsoft
recommends Windows Authentication mode, but legacy
applications may require SQL Server authentication.

8. Complete the installation.

Installing Microsoft Exchange Server2010 on VM #2

We performed a basic installation of Exchange Server 2010. For

complete details on the installation of Exchange Server 2010, see

Appendix D.

1. Install the Web Server (lIS) role and necessary role services,
.NET Framework, and the latest available Microsoft Filter Pack.
Also, set the Net.Tcp Port Sharing Service to start
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automatically, and install the Remote Server Administration
Tools pack. Reboot the server.

2. Insert the Exchange 2010 installation DVD, and capture the
DVD drive to the virtual machine. When the Autoplay window
appears, click Run Setup.EXE (see Figure 10).

Plan

Read about Microsoft Exchange Server 2010
Read about deploying languages

Read the Microsoft Exchange release notes

Install

Step 3: Choose Exchange language option
Step 4: Install Microsoft Exchange
Step 5: Get critical updates for Microsoft Exchange

Choose the source of the languages to be
installed Enhance

Install Microsoft Forefront Protection 2010 for Exchange Server

Microsoft”

Exchange Server 2010 Cose |

Figure 10: The main installation menu for Exchange Server 2010.

3. The installer should consider steps 1 and 2 to be complete
(they will appear grayed out). Click the link to Step 3: Choose
Exchange Language Option and install only languages from the
DVD.

4. Click the link to Step 4: Install Microsoft Exchange Server 2010.

5. On the introduction screen, click Next, and accept the license
agreement.

6. Select Typical Exchange Server Installation, and click Next (see
Figure 11).
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Exchange Server 2010 Setup

M Introduction Installation Type
Select the Exchange Server installation type:

[ License Agreement

I Enmor Reporting ‘l;: / Typical Exchange Server Installation
mT = The following will be installed on this computer:

Customer Experience — - Hub Transport

o - Client Access
Improvement Program - Mailbox

|/ Readiness Checks - Exchange Management Tools

[ Installation Type

.| Progress

3 Completion 4 ":V Custom Exchange Server Installation
i@" Use this option to select which of the following roles you want to install on
jv— ! this computer:

- Hub Transport

- Client Access

- Mailbox

- Unified Messaging

- Edge Transport

- Exchange Management Tools

Specify the path for the Exchange Server program files:
lC:\Program Files\Microsoft\Exchange Server\V14 Browse... |

Heb | <Back |[ Next> Cancel

Figure 11: Exchange Server 2010 Installation type selection screen.

7. Leave the organization name at default (First Organization),
and click Next.

8. To enable compatibility with previous Outlook 2003 clients, at
the question about client computers running Outlook 2003 or
Entourage, select Yes, and click Next.

9. Click Next to accept defaults for Configure Client Access server
external domain, and select your preference for the Customer
Experience Improvement Program.

10. The installation will now perform a readiness check. (If a
warning about a lack of SMTP appears after the check finishes,
ignore it. We will address this later.) To start the installation
process, click Install (see Figure 12).
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NN Exchange Server 2010 Setup
&V

P Introduction Readiness Checks
The system and server will be checked to verify that Exchange is ready to be installed.

B License Agreemert Elapsed time: 00:02:01

B Eror Reporting Summary: 5 tems). 5 succesded, Ofaied.
[ Installation Type — ”
& Organization Prerequisites {8 P
n Exchange
Organization Waming:
I . Setup is going to prepare the organization for Exchange 2010 by using "Setup
I3 Client Settings /PrepareAD". No Exchange 2007 server roles have been detected in this topology.
Corfigure Client After this operation, you will not be able to install any Exchange 2007 server roles.
Access server
extemal domai
o Elapsed Time: 00:01:03
n Customer Experience —
Improvement Program & Languages Prerequisites "@< Completed X
[ Readiness Checks Elapsed Time: 00:00:13
O P = -
= e = Hub Transport Role Prerequisites @ completed A
[ Completion -
Elapsed Time: 00:00:15
b Client Access Role Prerequisites r‘(_}‘w Completed &
Elapsed Time: 00:00:14
i‘ Mailbox Role Prerequisites v.'(:)\ Completed A
Elapsed Time: 00:00:15

To copy the contents of this page, press CTRL=+C.

Help <Back |[ mstal | cancel

Figure 12: Readiness Checks status and install screen.

11. Once the installation has completed, click Finish. Exchange
should automatically open the Exchange Management
Console (see Figure 13).
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Exchange Server 2010 Setup

1 Introduction Completion
: The following server roles have been successfully installed. To close the wizard, click
[ License Agreement =t
[ Emor Reporting Elapsed time: 00:35:27
[ Installation Type Successfully installed. Mo emors.
Exchange & Organization Preparation @ ol
Crganization -
=} d Time: 00:05:22
[ Client Settings B L=
Corfigure Client & Preparing Setup (/] &
n &cef::l sde.f:n:n Elapsed Time: 00:00:00
n Customer Experience & Stopping Services -'@- e
Improvement Program
Elapsed Time: 00:00:00
[ Readiness Checks =
I Progress & Copy Exchange Files -'n_&- 3
M Completion Elapsed Time: 00:05:44
11| Language Files .'@- Py
Elapsed Time: 00:14:51
. Restoring services (7] Py LI
To copy the contents of this page, press CTRL=+C.
View Setup Log
¥ Finalize this installation using the Exchange Management Consale
Help < Bacle | Finish I Cancel

Figure 13: Installation complete screen.

NOTE In order to receive external email, you will need to contact your

Internet Service Provider (ISP) to register your MX record associated

with your email server’s external IP address. You will also need to
establish routes in your firewall to direct all SMTP traffic to your

Exchange Server 2010 IP address.

Installing Microsoft SharePoint Server2010 on VM #3
When we installed SharePoint Server 2010, we followed the server

farm installation procedure. For complete details on the installation
of SharePoint Server 2010, see Appendix D.
1. Insert the installation DVD, and capture the DVD drive in the

VM session. Launch setup.exe, and click Install software
prerequisites (see Figure 14).
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Microsoft*

SharePoint Server 2010

&

=Y

are regu irements

Figure 14: The main installation menu for SharePoint Server 2010.

2. When the prerequisites finish installing, click Install SharePoint
Server on the main SharePoint installation menu.

3. Choose the Stand-alone server type, and click Install (see
Figure 15).
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Select the type of installation you want 1o install on the server,
" Complete - Install all components, Can add servers to form a SharePont farm,
& Stand-slone - Instal all components on a single machine (Inchudes SQL Server 2008

Express Edition). Cannot add servers to areate a SharePont farm. Cick the Help button
for more information about using this type of installation in production.

Figure 15: Selecting the server type.

4. When the installation finishes, check the box for Run the
SharePoint Products Configuration Wizard now, and click
Close.

5. When the configuration completes successfully, click Finish.
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SUMMING IT ALL UP

High availability infrastructures are an essential part of any business.
To keep your data going and your company moving along, you need a
system that not only handles your business in an effective, structured

manner, but one that won’t fail.

Dell 3-2-1 Reference Configurations, which include the latest Dell
PowerEdge servers and Equallogic storage, provide you and your
business with the tools to design and deploy a virtualization

infrastructure with no hassles and continued support.

As we have shown in this Guide, a Dell 3-2-1 Reference Configuration
takes the guesswork out of the typically complicated task of
designing, setting up, and configuring a virtual infrastructure, and

instead makes the process simple and straightforward.
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APPENDIX A —SETTING UP THE SHARED STORAGE AND NETWORKING

Adding the Hyper-V role

w

© % N o U &

11.

12.

Open Server Manager, and click Roles.
Click Add Roles.

On the Before You Begin page, check the Skip this page by
default box, and click Next.

Select Hyper-V, and click Next.

On the Hyper-V Introduction page, click Next.
On the Create Virtual Networks page, click Next.
Confirm installation selections, and click Install.
Once the installation is complete, click Close.

When the system prompts a restart, click Yes.

. Allow the system to fully reboot, and login using the

administrator credentials.

Once the desktop loads, the Hyper-V Installation Results
window will finish the installation.

Click Close. The Hyper-V role will now be available in Server
Manager under Roles.

Installing the failover clustering feature on the Hyper-V host servers

1.

2
3.
4
5

Open Server Manager, and click Features.
Click Add Features.

Select Failover Clustering, and click Next.
Click Install.

Once the new feature installation completes, click Close.

Installing Dell EqualLogic Host Integration Tools

1. Insert the disk and click Setup.exe.
2. At the Welcome screen, click Next.
3. Atthe License Agreement screen, review and accept the terms
of the license agreement, and click Next.
4. Atthe Installation Type screen, select Typical (Requires reboot
on Windows Server platforms), and click Next.
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10.

11
12.

Running the Remote Setup Wizard fo

In the Microsoft iSCSI Initiator service is not running pop-up,
click Yes to start the service and enable iSCSI traffic through
the firewall.

In the Microsoft iSCSI service pop-up, click Yes.

When the iSCSI Initiator Properties window pops up, accept
the defaults , and click OK.

If a Windows Firewall Detected pop-up appears, click Yes to
enable echo requests.

. At the Ready to install the components screen, click Install.

In the Microsoft Multipath I/O feature is not detected pop-up,
click Yes to install the feature.

When installing HIT on a failover cluster node, there will be an
additional screen called the Cluster Access Information screen.
Enter the appropriate credentials, specify a shared network
path, and click Next. For more information regarding installing
HIT on a failover cluster, see the HIT User’s Guide
documentation provided with your Dell EqualLogic PS4000XV.

. At the Installation Complete screen, click Finish.

In the System Restart Required pop-up, select Yes, | want to
restart my computer now, and click OK.

r the Dell EqualLogic PS4000XV

1. Click Start=>All Programs—>Equallogic, and open Remote
Setup Wizard.

2. At the Welcome screen, leave the radio button on Initialize a
PS Series array, and click Next. The Remote Setup Wizard will
search for uninitialized PS Series arrays.

3. At the All PS Series arrays have been initialized screen, select
the storage array, and click Next. (See Figure 16.)

Dell 3-2-1 Reference Configurations: High-availability A Principled Technologies configuration guide 30

virtualization with Dell PowerEdge R515 servers



Remote Setup Wizard i 5]

All PS Series arrays have been initialized.

All PS Series arrays have been initialized.

Serial Number | Fimware | RAID Levels | Host Adapter Name
SHU0937897Q0026 5,10, 50, 6 [ Broadcom BCM5709C

l Find Nezt I ——IR 0s

< Back Next > Cancel |

Figure 16: The All PS Series arrays have been initialized screen.

4. At the Initialize Array screen, enter the appropriate
information. For our testing, we used PS4000storage for
Member Name, 192.10.1.11 for IP Address,
255.255.255.0 for Subnet Mask, and 192.10.1.1 for
Default Gateway. (See Figure 17.)

Remote Setup Wizard ) x|

Initialize Array with Serial Number 'SHU0937897Q0026

— Member Information

Member Name |PS4DDDStorage

___IPAd__dress| 192.10 . 1 . 1|

Subnet Mask | 255.255.255. 0

DefaultGatewazl 192.10 . 1 . 1

— Group Information

¥ Createanewgoup ¢ Join an existing group More Information

< Back Next > Cancel

Figure 17: The Member Information screen.
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5. Under Group Information, leave the Create a new group radio
button selected, and click Next. (See Figure 17.)

6. Atthe Create a New Group screen, enter the appropriate
information. For our testing, we used grpmanager for the
Group Name, and 192.10.1.10 for the Group IP Address.
(See Figure 18).

Remote Setup Wizard i x|

Create a New Group

r Group Information RAID Policy

Group Name Igrpmanager
lRAIDw 'I
Group IPAddressl 1925100 10
More Information

r— Credentials for New Group
Confirm |

Admin Password (for ‘grpadmin’)

Membership Password |-- Confirm |--

— CHAP credentials for VDS/VSS access to group

User name [admin

Password (12 to 16 characters) I"“"‘“‘“““ Confirm I""‘"““““"‘I

< Back Next > Cancel |

Figure 18: The Create a New Group screen.

7. On the Create a New Group screen, select the desired RAID
level. We selected RAID 10 for the RAID Policy. (See Figure 18.)

8. Under Credentials for New Group, enter the passwords. (See
Figure 18.)

9. Under CHAP credentials for VDS/VSS access to group, enter a
user name and password and click Next. (See Figure 18.)

10. On the Initialization Successful pop-up, click OK.
11. Click Finish.

Configuring MPIO settings

1. Click Start=>All Programs—>EqualLogic=>Remote Setup
Wizard.

2. Atthe Welcome to the Remote Setup Wizard screen, select
Configure MPIO settings for this computer, and click Next.
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3. Under Subnets included for MPIO, select the subnets you wish
to exclude from MPIO.

4. Click Exclude.
5. Click Finish.
Configuring the Dell EqualLogic PS4000XV storage

1. Click Start->Internet Explorer, and enter the IP address of the

Dell EqualLogic PS Series Group Manager. For our testing, we
used 192.10.1.10.

2. Loginto the group manager using the credentials you created
during the Remote Setup Wizard.

3. Expand Members, click the member PS4000Storage (see
Figure 19), and, in the right pane, select the Network tab.

/= grpmanager - EqualLogic PS Series Group Manager - Windows Internet Explorer I =181 x|
= 9 7
@:: < [B e 192.10.1.10 =l &[4 )[x|[&sng 2|

5. Favorites \ 55 @] SuggestedSites v | Web Sice Gallery ~

¥ grpmanager - EqualLogic PS Series Group Manager

3 ~ B - [ o= v Page~ Safety~ Toos~ @~

Member PS4000Storage

£1 Group grpmanager m— - - z =
44 Group Configuration Activities Status | (Enclosure | Controllers | Disks | Network | Connections | "Service
Storage Pools i -
= ;Memhgeys Eaiember PIICIIS., General Member Information Q
=3 PS4000Storage| M:'"b" Status: @ online General Settings RAID Status
Liodity member settings, Model: 70-0120 Member name: PS4000Storage RAID Status: « OK
@ Modify RAID confiquration Product family: PS4000 Storage pook: default
® Delete member Chassis type: 1603 RAID policy: RAID-10
@ Update member frmware Disks: 16 (SAS HDD)
Identification ISCS| connections: 0
@ Start LEDs flashing
Member Health Status (2]
Front view Rear view
§ -
= Grow
[ Volumes
& Replication
o Total member capacity: 2.74 TB
g Monitoring Used by volumes: 0 MB (0%)
Gl Used by snapshots and replicas: 0 MB (0%)
Tools iy | <
[pone

[T [ [ [ [ [ |@ ntemet |Protected Mode: OFf Jav [®100% -

Figure 19: Navigating to the storage.

4. Right-click eth1, and select Modify IP settings.

5. Enter the desired IP address for the second iSCS| connection
and click OK. For our testing we used 192.10.1.12 for the IP
address and 255.255.255.0 for the Subnet mask

6. Right-click eth1, and select Enable interface.

7. Repeat steps 4 and 5 for eth2 which is the management port,
and apply the appropriate IP address and subnet mask. For
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our testing, we used 192.20.1.10 for the IP address, and
255.255.255.0 for the subnet mask.

8. Create the volumes:

a. Inthe left pane, click Volumes, and, in the adjacent
pane, click Create volume. (See Figure 20.)

/= grpmanager - EqualLogic PS Series Group Manager - Windows Internet Explorer -18]x]
@@vfn—;w-m: 192.10.1.10 H (&[4 )lx][Ssno Ll

Jig Favorites |5 2 Suagested Sites ~ @ | Web Slice Gallery ~

¥ grpmanager - EqualLogic PS Series Group Manager

Volumes

Volumes

Total volumes: 0. Online volumes: 0

i
§Wlumss o

& Volume Collections

Custom Snapshot Collections -
o » ? Administration [ Organize by volume type
@ Create volume Yolume u[Storage  [Reported  [volume: Snapshot  |Volume  [Replication Number of [iSCST
pool size reserve |reserve  |status |partner snapshots |connections|

name.

= Group.
Q Volumes
f monitoring
s
—
Tools iy [ Atarms [ Operations
Pone [ [ [ [ [ | mternet | Protected Mode: Off 7a- [Ri0% v

Figure 20: The Volumes pane.

b. Name the volume VirtualMachinel, and click Next.

c. Type 70 for the Volume size, and click Next. For our
testing purposes we did not create a snapshot reserve
with the volume. (See Figure 21.)
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Step 2 - Space ?

Volume space

* Volume size: (max. 797 .4 GB)

[:] Thin provisioned volume (use sliders below to adjust settings)

Snapshot space
* Snapshot geserve:D % of volume reserve

£ Reported volume size 70 GB 2]

@ Estimated changes in storage pool default @

[ Voumeresene [0 | cow|  no
Snapshot reserve g 210 MB

Replication reserve ) OMB
-

Delegated space | ] 0MB
Free pool space b 7274 GB

Figure 21: Setting the Volume size.

d. On the Step 3 —iSCSI Access screen, click the Allow
simultaneous connections from initiators with different
IQN names checkbox, and perform the following,
depending on the volume you are creating:

a. Forthe VirtualMachinel-3 and DiskWitness
volumes, click the Limit access to iSCSI
initiator name radio button, and enter the
appropriate iSCSI initiator name. For our
testing, thiswas igqn.1991-
05.com.microsoft:hypervhostl.te
st.local

b. For the SharePoint, Exchange, and SQL Server
volumes, leave the no access radio button
selected since you will enter the IQN name of
the appropriate VM later.

e. Click Finish.
9. Repeat step 8 eight times for the remaining volumes, using

the following names and Volume sizes:

e VirtualMachine2 — 70GB
e VirtualMachine3 — 70GB
e SharePoint — 500GB
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e Exchange —500GB

e Exchangelog—-125GB

e SQlLData—-500GB

e SQllLog—125GB

e DiskWitness — 10 GB
Connecting to the volumes with Microsoft iSCSI Initiator

1. Click Start-> Administrative Tools=iSCSI Initiator.
2. Select the Discovery Tab, and click Discover Portal.

3. Enter the IP Address for the Dell EqualLogic Storage Group,

and click OK.
OTE The Discovery tab now shows the Target portal you added (see
NOT Figure 22.)
=
RADIUS | Configuration | = Dell Equallogic MPIO |
| Targets Discovery I Favorite Targets | Volumes and Devices
[ Target portals

The system will look for Targets on following portals: &I

Address I Port ] Adapter | IP address |

192.10.1.10 3260 Default Default

To add a target portal, dick Discover Portal.

To remove a target portal, select the address above and |
then dick Remove. Remove

[-ISNS servers

The system is registered on the following iSNS servers: &]

Name |
To add an iSNS server, dick Add Server. Add Server... |
To remove an iSNS server, select the server above and e

then dick Remove.

More about Discovery and iSNS

OK I Cancel | Apply |

Figure 22: The Discovery tab showing the Target
we added.

4. Select the Targets tab, and click Refresh.

5. Select the first Inactive Target listed, and click Connect.
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6. Ensure that the Add this connection to the list of Favorite
Targets is selected, check the Enable multi-path check box,
and click OK. (See Figure 23.)

Connect To Target » x|

Target name:
| uallogic:0-8a0906-8b640fc03-d200000000b4d9a2-virtualmachines

v Add this connection to the list of Favorite Targets.
This will make the system automatically attempt to restore the
connection every time this computer restarts.

v Enable multi-path

Advanced... I OK Cancel

Figure 23: Connecting to a Target.

7. Repeat steps 5 and 6 three times, until you’ve connected to all
four volumes, and click OK.

Installing Broadcom Advanced Control Suite

1. Onthe Dell Update Package pop-up for installing Broadcom
NetXtreme Family of Adapters, click Install...

2. On the InstallShield Wizard welcome screen, click Next.

3. Click the | accept the terms in the license agreement radio
button, and click Next.

4. Under Drivers and Management Applications, click Control
Suite, click BASP, select to install this feature on the local hard
drive in the drop down menu, and click Next. (See Figure 24.)
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i Broadcom Drivers and Management Applications - InstaliShield Wizas

Custom Setup
Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.

o e e i~ Feature Description
= Q | Drivers and Management Applications This feature will install the
& /3~ Control suite Broadcom Advanced Server

| b Program. This NDIS intermediate

e X v | SNMP driver software allows for load

i 3+ | CIM Provider balmott\lg;saf\d failover, and VLAN
This feature requires 9504KB on
your hard drive.

InstaliShield

Help | < Back Next > Cancel

Figure 24: Selecting BASP for installation

5. On the Ready to Install the Program screen, click Next.

6. At the pop-up warning screen, click Yes. (See Figure 25.)

[N Broadcom Management Program 5‘

% The installer has detected that system and network performance
_,.-' could be improved if System TCP Chimney Offload is set to
enabled. Would you like this setting to be changed by the
Broadcom Installer?

v § s

Figure 25: Broadcom Management Program pop-up

7. On the InstallShield Wizard Completed screen, click Finish.
8. At the Update Package Complete screen, click OK.

Configuring a NIC team with the Public/VM NICs in BACS

1. Click Start=>All Programs—>Broadcom—>Broadcom Advanced
Control Suite 3.

2. Click Team Management. (See Figure 26.)
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Figure 26: Team Management view

3. Click Teams from the taskbar, and select Create a Team to
launch the Broadcom Teaming Wizard.

4. At Welcome to the Broadcom Teaming Wizard screen, click
Next.

5. In the textbox, type the name of the team (in our case, Public-
VM Teamed NIC), and click Next.

6. For Team type, select the Smart Load Balancing™ and Failover
(SLB) radio button, and click Next.

7. At the Assigning Team Members screen, select the two Public-
VM dedicated NICS and click Add, then click Next. (See Figure
27.)
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Creating/Modifying a Team: Assigning Team Members n
Specify which adapters to include in the team. BROADCOM.
Include adapters that you wish to set for the standby role. 7 P~

<

Available Adapters

[7oE_[1s0__[co [Rss |1

[0022] Broadcom BCM5716C NetXtreme Il GigE (NDIS VBD Client) #34 No Yes Yes Yes Y
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[0025] Broadcom BCM5703C NetXireme Il GigE (NDIS VBD Client) #51  Yes Yes Yes Yes Y
[0026] Broadcom BCM570SC NetXtreme |l GigE (NDIS VBD Client) #52 Yes Yes Yes Yes Y

= |13

Team Members

{[0024] Broadcom BCM570SC NetXtreme I ..

Team Offload Capabiliies LS0. CO. RSS
Team Mu 1500
Click here for more information about corfiguring teaming.
Preview |
Cancel | <Back | Next >

Figure 27: Assigning team members

8. Select Do not configure a standby member, and click Next.

9. On the Configuring LivelLink screen, select the No radio button,
and click Next.

10. On the Configure VLAN Support screen, select the Skip
manage VLAN radio button, and click Next.

11. Under Commit changes, select the Commit changes to system
and Exit the wizard radio button, and click Finish.

12. On the pop-up that states Applying the changes will
temporarily interrupt the network connection, click Yes. When
the configuration process finishes, you should see the newly
created virtual adapter from the teamed NICs, as Figure 28

shows.
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Figure 28: New virtual adapter from teamed NICs

Configuring the Dell EqualLogic PS4000XV for access from the second Hyper-V host server

1. Click Start->Internet Explorer, and enter the IP address of the
Dell EqualLogic PS Series Group Manager. For our testing, we
used 192.10.1.10.

2. Log into the group manager using the credentials you created
during the Remote Setup Wizard.

3. Click on the Volume VirtualMachinel, click the Access tab, and
click Add.

4. Check the Limit access to iSCSI initiator name checkbox and
enter the iSCSI initiator name of the second Hyper-V host

server and click OK. For our testing, thiswas ign.1991-
05.com.microsoft:hypervhost2.test.local

When you’ve successfully given access to the second Hyper-V host,
NOTE the Access Control List screen looks like Figure 29.
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Figure 29: Access control addition successful.
5. Repeat steps 3 and 4 three times for the remaining volumes:

e VirtualMachine2
e VirtualMachine3
e DiskWitness

Creating a VLAN and assigning ports on the Dell PowerConnect 6248 switch

1. Open a Web browser and enter the IP address of the switch.
For our testing, this was 192.20.1.250.

2. Enter the appropriate login credentials.

w

In the left pane, expand Switching, VLAN, and click VLAN
Membership.

In the right pane, click the Add button.
Enter the first VLAN ID and Name, and click Apply Changes.

Repeat step 5 twice to create the remaining VLANSs.

N o v &

When you finish, click Back. The VLAN drop-down menu
should show the newly created VLANSs.

8. To add a port to a VLAN, select the appropriate VLAN from the
drop down menu and click on the desired ports in the Static
row (See Figure 30).
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Figure 30: Assigning ports to a VLAN

9. Click Apply Changes to save the VLAN port assignments.

10. Repeat steps 8 and 9 twice to complete the port assignments
for the remaining two VLANs on Unit 1, then click to select
Unit 2 (the other switch) and repeat steps 8 and 9 for all
VLANS.
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APPENDIX B — PREPARING THE FAILOVER CLUSTER AND
CONFIGURING THE MANAGEMENT SERVER

Creating a self-signed certificate

W N O ¢ kR WNR

12.
13.

Click Start—=>Run.

Type mmc, and click OK.

When the console opens, click File>Add/Remove Snap-in...
Under Available snap-ins, select Certificates, and click Add.
Select Computer account, and click Next.

Select Local computer, and click Finish.

At the Add or Remove Snap-ins window, click OK.

On the left-hand side, expand Certificates (Local Computer).

Right-click Personal, and click All Tasks>Request New
Certificate.

. On the Before You Begin page, click Next.
11.

On the Select Certificate Enrollment Policy page, click Active
Directory Enrollment Policy, and click Next.

Check the Computer box, and click Enroll.

Once the certificate installation completes, click Finish. The
new certificate will now be listed under Certificates (Local
Computer)->Personal->Certificates.

Installing Dell OpenManage Server Administrator 6.4

1. Insert the installation disk for Dell OpenManage Server
Administrator into the DVD drive.

2. When the AutoPlay window appears, click Run autorun.exe.

3. When the Dell OpenManage Install window appears, click
Install.

4. The install wizard will then scan for prerequisites.

5. If a Remote Enablement warning is listed, click the link to
configure HTTPs Listener Windows Remote Management.

6. When the Are you sure you want to configure HTTPs Listener
Windows Remote Management prompt appears, click Yes.

7. When the configuration tool completes, click Rescan
Dependencies.
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8. When the scan completes, click Server Administrator.

9. Atthe Welcome to the Install Wizard for Dell OpenManage
Server Administrator screen, click Next.

10. Accept the license agreement, and click Next.
11. At the Setup Type screen, select Custom, and click Next.

12. At the Custom Setup screen, click Server
Instrumentation—=>Remote Enablement—=>This feature will be
installed on the local hard drive, and click Next.

13. At the Ready to Install the Program screen, Click Install.
14. Once the installation completes, click Finish.

Running the Validate a Configuration Wizard
1. Open Server Manager.
2. Expand Features, and select Failover Cluster Manager.
3. Click Validate a Configuration...

4. On the Before You Begin page, check the Do not show this
page again box, and click Next.

5. Atthe Select Servers page, type the name of each Hyper-V
host server and click Add. After adding both servers, click
Next.

6. On the Testing Options page, select Run all tests
(recommended), and click Next.

7. On the Confirmation page, click Next to begin running the
validation tests.

8. Once the validation tests complete successfully, click Finish.
Creating and configuring the cluster

1. Open Server Manager.

2. Expand Features, and select Failover Cluster Manager.
3. Click Create a Cluster...
4

On the Before You Begin page, check the Do not show this
page again box, and click Next.

5. On the Select Servers page, type the name of each Hyper-V
host server and click Add. After adding both servers, click
Next.
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10.

11.
12.
13.

14.

15.
16.

17.

18.

19.

20.

On the Access Point for Administering the Cluster page, enter
a cluster name.

Select a valid network, enter the desired IP address, and click
Next.

On the Confirmation page, click Next.
Once the new cluster is created and configured, click Finish.

The new cluster now appears under Server
Manager—>Features—>Failover Cluster Manager.

Select the newly created cluster.
Click Enable Cluster Shared Volumes...

Read the notice window that appears, check the | have read
the above notice box, and click OK.

On the left-hand side of the Server Manager window, expand
the new cluster, and click Cluster Shared Volumes.

Click Add storage.

Select the desired disks, and click OK to add the disks to the
cluster.

Once the Add storage task completes, the added disks will
now be listed on the main page for Cluster Shared Volumes.

Next, expand Networks in the left pane, right-click on the first
cluster network in the center pane, and click Properties.

Determine, based on the listed subnet identifying the network
type, whether each network will allow cluster network
communication and whether clients will be able to connect
through the network. For example, using our sample IP
scheme, the subnet 192.10.1.0 is our iSCSI network, so we
selected Do not allow cluster network communication on this
network.

Be sure to take note of which cluster network has the subnet
that corresponds to the Private/CSV network, as you will need
this information to complete the next step. In our test setup,
this subnet is 192.30.1.0 and was assigned as Cluster Network
4.

Next, designate the Private/CSV network as the preferred
network for CSV communication. Click Start=>Administrative
Tools>Windows PowerShell Modules.
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21.Type Get-ClusterNetwork | ft Name, Metric,
AutoMetric, Role and press Enter to view the current
preferred network assignments.

22.Type (Get-ClusterNetwork “Cluster Network
4”) .Metric = 900, where “Cluster Network 4” is the
Private/CSV Network, and press Enter to set it as the preferred
network. Setting the Metric to a lower value than the other
networks, in this case a value of 900, will make it the preferred
network for CSV communication. To confirm the change,
repeat step 21 and verify that Cluster Network 4 now has a
Metric value of 900. For more information, see
http://technet.microsoft.com/en-
us/library/ff182335(WS.10).aspx

23. Close the PowerShell Module window.
Configuring the networks for cluster access

1. Open Server Manager, and click Features.

2. Click Add Features.

3. Onthe Select Features page, expand Role Administration
Tools, and select Hyper-V Tools.

4. Expand Feature Administration Tools, and select Failover.
Installing Hyper-V Tools and failover clustering tools

1. Open Server Manager, and click Features.

2. Click Add Features.

3. On the Select Features page, expand Role Administration
Tools, and select Hyper-V Tools.

4. Expand Feature Administration Tools, and select Failover
Clustering Tools.

5. Click Next.
6. On the Confirm Installation Selections page, click Install.
7. Once the installation is complete, click Close.

Installing Systems Center Essentials 2010

1. Insert the System Center Essentials installation DVD into the
DVD drive.

2. When the AutoPlay window appears, click Run setupSCE.exe.
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10.

11.

12.

13.

14.

15.

16.

17.

At the System Center Essentials 2010 Setup window, check the
Download the latest updates to System Center Essentials 2010
during setup box, and click Install.

On the Product registration information page, enter a name,
an organization, and your product key, and click Next.

When prompted, install .NET Framework 3.5 SP1.

At the license agreement, check the | have read, understood,
and agree with the terms of the license agreement box, and
click Next.

On the Select components to install page, ensure that all
components are selected and click Next.

The wizard will then check the environment for prerequisite
hardware and software. Review and correct any prerequisite
warnings, and click Next.

On the Setup will install these missing software prerequisites
page, select Install Internet Information Services (IS) and
Install SQL Server 2008 SP1 on this computer now, and click
Next.

When all prerequisite installations complete successfully, click
Next.

On the Where should System Center Essentials files be located
page, click Next.

On the Where should Virtualization Management data be
located page, accept the default location, and click Next.

On the Provide management account credentials page, enter
the administrator user name and password, then enter the
proper domain name, and click Test.

When the test completes, click Next.

On the Help improve System Center Essentials page, select No
for all three items, and click Next.

On the Ready to install System Center Essentials page, review
the Essentials Server and Essentials Reporting settings, and
click Install.

When the installation completes successfully, check the Open
the System Center Essentials console when this wizard closes,
and click Close.
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Configuring Systems Center Essentials 2010

1. Onthe Get Started page, click Start.

2. Onthe Policy Type page, select Yes, and click Next.

3. Onthe Firewall Exceptions page, select Yes, create Windows
Firewall exceptions (recommended), and click Next.

4. On the Configure Remote Assistance page, select No, do not
enable Remote Assistance, and click Next.

5. On the Computer Discovery page, select Yes.

6. Select Automatically discover and manage all computers, and
click Next.

7. On the E-mail Notifications page, select No, | will set up
notifications later, and click Next.

8. On the Proxy Server page, select No, and click Synchronize.

9. Once the synchronization is complete, click Next.

10. On the Monitoring Configuration page, leave default
selections, and click Next.

11. On the Error Monitoring page, select Yes, collect application
errors (recommended), enter a valid directory for the Error
reporting upload location, and click Next.

12. On the Configure Error Forwarding page, click Next.

13. On the Microsoft Updates page, select Automatically
(recommended), and click Next.

14. On the Update Languages page, select Yes (recommended),
and click Next.

15. On the Update Classifications page, select Download only
critical, security, and service pack updates from Microsoft
(recommended), and click Next.

16. On the Update Deployment page, leave default selections and
click Next.

17. On the Summary page, review the configuration and click
Configure.

18. Once the configuration completes, check the Start discovering
computers to manage when this wizard closes, and click Close.
Allow for the SCE console to install management agents on the
discovered computers before proceeding.
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Adding the failover cluster as a virtual machine host in SCE 2010

1.
2.
3.

© ® N o u

11.
12.
13.

Open System Center Essentials 2010.
On the left-hand side, click Computers.

In the Computer Overview pane, click Designate a Host under
Virtualization.

On the Select a Computer screen, select the first virtualization
host.

Click Next.

Enter the administrator credentials and domain.
Click Designate.

When the validation prompt appears, click OK.

At the Network Configuration screen, click Next.

. Select the BASP Virtual Adapter and enter an appropriate

name for the virtual switch, then set all other network
adapters to Do not configure, and click Next.

Repeat step 10 for the second node.
At the Summary screen, click Create.

At the Completion screen, check the When the wizard closes,
take me to view the new host box, and click Close.

Importing the Dell PRO enabled management pack into SCE 2010

1.

w

® N o U &

Download the Dell PRO Pack 2.0 from

http://support.us.dell.com/support/downloads/download.asp
X?2c=us&cs=555&I|=en&s=biz&releaseid=R252410&formatcnt=
1&libid=0&typeid=-1&dateid=-1&formatid=-1&fileid=369241.

Double-click the downloaded file.

When the Open File — Security Warning window appears, click
Run.

At the Dell PRO Enabled Management Pack window, click OK.
Enter a location for the unzipped file, and click Unzip.

When the unzip process is complete, click OK.

Open Systems Center Essentials

When the System Center Essentials console appears, click
Administration on the left-hand side.
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9. Under Tasks, click Import Management Packs...

10. On the Select Management Pack page, click Add—>Add from
disk...

11. At the Online Catalog Connection prompt, click No.

12. Browse to the unzipped Dell PRO Pack, and click Open.
13. Once the Dell PRO Pack has been added, click Install.

14. At the System Center Essentials security prompt, click Yes.

15. Once the management pack is successfully imported, click
Close.
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APPENDIX C— CREATING AND CONFIGURING THE VIRTUAL MACHINES

Creating a virtual machine in SCE 2010

1. Open System Center Essentials 2010.

2. On the left-hand side, select Computers.

3. Onthe right-hand side, click New Virtual Machine under
Computer Group.

4. Atthe Select Template screen, select an appropriate template,
and click OK.

5. Atthe Installing Operating System screen, select Install from
DVD, insert the Windows Server 2008 R2 SP1 install disk into
the appropriate Hyper-V host server, and click Next.

6. Select a host for the new virtual machine, and click Next.

7. At the Virtual Machine Name screen, enter a name,
description, and host folder for the new virtual machine.

8. Click Next.

9. Atthe Summary screen, review the virtual machine settings,
and click Create.

10. When the virtual machine is successfully created, check the
When the wizard closes, open the Configure Virtual Machine
window to set up the virtual machine for management box.

11. Click Close.

12. When the Configure Virtual Machine window appears, click
Install an operating system. A VM window pops up showing
that the Windows Server 2008 R2 SP1 files are being loaded
from the DVD

13. At the Language Selection Screen, click Next.

14. Click Install Now.

15. Select Windows Server 2008 R2 Enterprise (Full Installation),
and click Next.

16. Click the | accept the license terms check box, and click Next.

17. Click Custom.

18. Click Next.
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19.

20.

21.
22,

At the User’s password must be changed before logging on
warning screen, click OK.

Enter the desired password for the administrator in both
fields, and click the arrow to continue.

At the Your password has been changed screen, click OK.

Click OK, and click Close to exit.

Configuring a virtual machine in SCE 2010

Before

proceeding with this section, ensure that you have configured

your virtual machine with an appropriate name and IP address, and

that it has been joined to the existing domain.

1.

At the Configure Virtual Machine VM1 screen, click 3. Add the
new virtual machine to management. (See Figure 31.)

*E Configure Virtual Machine VM1 B x|

Configuration steps required to manage this virtual machine

e

o More about configuring a virtual machine for management in System Center Essentials 2010

Control the new virtual machine using a standard mouse and keyboard

3. Add the new virtual machine to management

Run the 'Add new computers and devices' wizard to start monitoring the virtual machine's health.

_Close |

Figure

31: Adding the new virtual machine to management.

2.

On the What would you like to manage? screen, select
Windows computers, and click Next.

On the Auto or Advanced? Screen, select the Automatic
computer discovery radio button, and click Next.

On the Administrator Account screen, select the Use selected
Management Server Action Account, and click Discover.

On the Select Objects to Manage screen, select the
appropriate virtual machine and click Next.
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6. On the Summary screen, click Finish. The Agent Management
Task Status window will pop up and show the status of the
agent installation into the virtual machine.

7. When the task has completed and the Status says Success,
click Close. You should be able to see the newly added virtual
machine as Figure 32 shows.

@ System Center Essentials - MGMT-SERVER_MG
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Computers < Al Virtual Machines 1

4. [ Computer Groups P Edit Criteria v

% All Windows Clients (0)

VM Name state Job Status CPU Aver... | Computer Nar
i All Windows Computers: (5)
¥ All Windows Servers (5)
4 3 Al Virtual Machines (1)
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ML ) Running 2 VMLtest.k

[ virtualization Jobs (29)

A Computers
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£y Software

W Reporting

7]/} Administration

/ Authoring

Ready

Figure 32: The newly added virtual machine.

Configuring the Live Migration networks for the virtual machines
1. Click Start->Administrative Tools—>Failover Cluster Manager.
2. Click Manage a Cluster.
3. Enter the cluster name, and click OK.

4. Expand the cluster name, services and applications, and click
on SCVMM VM resources for the first virtual machine.

5. In the center pane, right-click SCVMM <virtualmachinename>,
and click Properties, where <virtualmachinename> is the
name of your VM.

6. Click the Network for live migration tab.

7. Use the Up and Down buttons to order the networks by
priority, with the dedicated Live Migration network first,
followed by the Private/CSV network, then the Public
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network, and verify that the iSCSI network is disabled for live
migration. Click OK.

This should automatically set the live migration priorities for all virtual
machines. For more information on the Live Migration network, go to

http://technet.microsoft.com/en-us/library/dd446679(WS.10).aspx.

Creating the iSCSI virtual network switches
1. Click Start->Administrative Tools—>Hyper-V Manager.

2. Ensure that New virtual network is highlighted in the left
pane, and External is highlighted in the right pane, and click
Add.

3. For the name, enter an appropriate name.
NOTE Be sure to use the same name for each of the virtual network
switches on the other Hyper-V host.
4. For connection type, select the External radio button, use the
drop down menu to select the first iSCSI physical adapter, and

ensure that the Allow management operating system to share
this network adapter checkbox is selected, and click Apply.

5. When the warning dialogue box appears, click OK.

6. Repeat steps 2 through 5 for the second iSCSI adapter, and
click Ok.

7. Repeat steps 2 through 6 for the second Hyper-V host,
ensuring that you use the same virtual network names.

Creating virtual network adapters
1. Click Start->Administrative Tools—>Hyper-V Manager.

Right-click on each of the VMs and shut down each one.

Right-click on the first VM, and select Settings...

W N

Ensure that Add Hardware is selected in the left pane, that
Network Adapter is selected in the right pane, and click Add.

5. Under Network, use the drop-down menu to select the first
iSCSI virtual network, and click Apply.

6. Repeat steps 4 and 5 to add the second iSCI network adapter,
connect it to the second iSCSI virtual network, and click OK.

Dell 3-2-1 Reference Configurations: High-availability A Principled Technologies configuration guide 55
virtualization with Dell PowerEdge R515 servers


http://technet.microsoft.com/en-us/library/dd446679(WS.10).aspx

7.

Repeat steps 3 through 5 for the other two VMs.

Enabling access to volumes on the storage level
Before completing the following steps, boot the VMs, assign IP

addresses to the iSCSI NICs, and install the HIT software into each VM.

1. Connect to the first VM, open a Web browser, and log into the
Equallogic PS Series Group Manager with the appropriate
credentials.

2. Expand the volumes, and select the appropriate volume.

3. Inthe right pane, click the Access tab, and click Add.

4. Atthe Create access control record screen, click limit access to
iSCSl initiator name, enter the name of the appropriate VM,
and click OK.

5. Repeat steps 2 through 4 for any additional volumes that you
need to enable access to for that VM. For example, for VM #1
you will need to enable access to both the SQLData and
SQLLog volumes. When you are finished, close the browser
window.

6. Click Start—>Administrative Tools—2iSCSI Initiator.

7. Select the Discovery Tab, and click Discover Portal.

8. Enter the IP Address for the Dell EquallLogic Storage Group,
and click OK.

9. Select the Targets tab, and click Refresh.

10. Select the first Inactive Target listed, and click Connect.

11. Ensure that the Add this connection to the list of Favorite
Targets is selected, check the Enable multi-path check box,
and click OK.

12. Repeat steps 10 and 11 if needed for additional volumes, and
click OK.

13. Repeat steps 1 through 12 for the other two VMs.

14. Right-click the first VM, and click Settings...
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APPENDIX D — CUSTOMIZING YOUR VIRTUAL MACHINES

Installing SQL Server 2008 R2 on VM #1
Install an instance of Microsoft SQL Server 2008 R2 by following these

steps. This installation walkthrough covers only the installation of the
Database Engine and Management Components. For other
components outside the scope of this guide, such as Reporting
Services, Integration Services, or Analysis Services, see Microsoft

documentation at http://msdn.microsoft.com/en-

us/library/ms143219(SQL.105).aspx.

1. Onthe management server, click the Start button, and click
Hyper-V Manager.

2. Select the appropriate Hyper-V Host machine, right-click the
virtual machine you wish to install SQL Server on, and choose
to connect.

3. Log into the virtual machine.

4. Insert the installation DVD for SQL Server 2008 R2 into the
appropriate Hyper-V host server’s DVD drive.

5. Using the Hyper-V menu, choose Media, and Capture D: Drive,
where D: is the letter of the physical server’s DVD drive.

6. Click Run SETUP.EXE. If Autoplay does not begin the
installation, navigate to the SQL Server 2008 R2 DVD, and
double-click.

7. If the installer prompts you with a .NET installation prompt,
click Yes to enable the .NET Framework Core role.

8. At the SQL Server Installation Center screen, click Installation.
Click New installation or add features to an existing
installation.

9. At the Setup Support Rules screen, click OK.

10. At the Product Key screen, enter your licensing information, if
applicable, and click Next.

11. At the License Terms screen, accept the license terms, and
click Next.

12. At the Setup Support Files screen, click Install.
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13.
14.

15.

16
17.

18.
19.

20.

21.

22.
23.
24,
25
26.

At the Setup Support Rules screen, click Next.

At the Setup Role screen, choose SQL Server Feature
Installation, and click Next.

At the SQL Server 2008 R2 Feature Selection screen, select the
features that your organization requires. We chose the
following features for this guide: Database Engine Services,
Client Tools Connectivity, Client Tools Backwards
Compatibility, Management Tools — Basic, and Management
Tools — Complete. Click Next.

. At the Installation Rules screen, click Next.

At the Instance Configuration, enter the appropriate details
for your configuration. For a default instance, leave the
defaults selected. For a named instance, enter a new instance
name and adjust the file paths as necessary.

At the Disk Space Requirements screen, click Next.

At the Server Configuration screen, choose the service
account, preferably an Active Directory domain account, fill in
a password if necessary, and click Next.

At the Database Engine Configuration screen, choose an
authentication mode. If your legacy servers use SQL Server
logins at all, select Mixed Mode. If you exclusively use Active
Directory domain accounts in your SQL Server environment,
choose Windows Authentication.

If you choose to use Mixed Mode authentication, enter a
password for the system administrator (SA) account, click Add
Current User, and click Next.

At the Error Reporting screen, click Next.
At the Installation Configuration Rules screen, click Next.

At the Installation screen, click Install.

. At the Complete screen, click Close.

After the SQL Server 2008 R2 installation process completes,
check Microsoft’s Web site for the latest SQL Server service

pack and install that service pack. At the time we wrote this

Guide, there were none.

Installing Exchange Server 2010 SP1 on VM #2

1.

Select Start->Administrative Tools—>Server Manager.
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12.
13.
14.
15.

16.
17.

18

22.
23.
24,

25.

Click Add Roles.
At the Before You Begin screen, click Next.
At the Select Server Roles screen, click Web Server (l1S).

If prompted by an Add features required for Web Server (IIS)
pop-up window, click Add Required Features.

Click Next.

. At the Web Server (lIS) screen, click Next.

At the Select Role Services screen, select the |IS 6 Metabase
Compatibility, IIS 6 Management Console, Basic
Authentication, Windows Authentication, Digest
Authentication, and Dynamic content Compression
checkboxes, and click Next.

. At the Confirm Installation Selections screen, click Install.
10.
11.

At the Installation Results screen, click Close.

Select Start->Administrative Tools—>Server Manager.
Click Features.

Click Add Features.

Select .NET Framework 3.5.1 Features.

When the Add Features Wizard pop-up window prompts you,
click Add Required Role Services.

Click Next.

At the Introduction to Web Server (lIIS) screen, click Next.

. At the Select Role Services screen, click Next.
19.
20.
21.

Click Install.
At the Installation Results screen, click Close.

Download the Microsoft Filter Pack 2.0.
(http://www.microsoft.com/downloads/en/details.aspx?Famil
yID=5cd4dcd7-d3e6-4970-875e-aba93459fbee )

Run FilterPackx64.EXE.
Click Next.

Click I accept the terms in the License Agreement, and click
Next.

Click OK once installation is complete.
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26.
27.

28.

29.

30.

31.

32.

33.
34.
35.
36.
37.
38.
39.

40.

41.

42.

43.

44.

Click Start=>Administrative Tools=>Services.

Right-click the Net.Tcp Port Sharing service, and click
Properties.

Change the Net.Tcp Port Sharing startup type to Automatic,
and click OK.

Open command prompt and type ServerManagerCmd -i
RSAT-ADDS, and hit Enter.

Reboot the server.

Insert the Exchange Server 2010 installation DVD, and capture
the DVD drive in the VM session. When the Autoplay window
appears, click Run Setup.EXE.

The installer should consider steps 1 and 2 to be complete
(they appear grayed out). Click the link to Step 3: Choose
Exchange Language Option.

Click Install only languages from the DVD.

Click the link to Step 4: Install Microsoft Exchange Server.
To go past the introduction screen, click Next.

Accept the license agreement, and click Next.

Select No for error reporting, and click Next.

Select Typical Exchange Server Installation, and click Next.

Leave the organization name at default (First Organization),
and click Next.

At the question about client computers running Outlook 2003
or Entourage, select Yes, and click Next.

To accept defaults for Configure Client Access server external
domain, click Next.

At the Customer Experience Improvement Program screen,
select | don’t wish to join the program at this time, and click
Next.

If a warning about a lack of SMTP appears after the check
finishes, ignore it for now. We address this issue in steps 42-52
below.

Click Install to start the installation process.
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45.

46.

47.

48.

49.

50.

51.

52.

53.

54.

55.

56.

Once the installation has completed, click Finish. Exchange
should automatically open the Exchange Management
Console.

If Exchange does not automatically open the Exchange
Management Console, click Start—>All Programs—> Microsoft
Exchange Server 2010 Exchange Management Console.

In the left pane, expand Microsoft Exchange On-Premises,
expand Organization Configuration, and select Hub Transport.

In the Actions pane on the far right, select New Send
Connector.

Name the send connector SMTP, select the intended use as
Internet, and click Next.

In the Address space window, click Add.

In the SMTP Address Space window, type * as the address,
ensure that the installer has checked Include all subdomains,
and click OK.

Click Next.

On the Network settings page select Use domain name system
(DNS) “MX” records to route mail automatically and click Next.

Accept the defaults in the Source Server window and click
Next.

At the New Connector page, click New to create the
connector.

Click Finish to close the New SMTP Send Connector wizard.

In order to receive external email, you will need to contact your

Internet Service Provider (ISP) or DNS provider to register the MX

record associated with your email server’s external IP address. You

will also need to establish routes in your Firewall to direct all SMTP

traffic t

o your Exchange Server 2010 IP address.

Installing SharePoint Server 2010 on VM #3

1. Insert the installation DVD, and capture the DVD drive in the
VM session.
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2. Launch setup.exe, and click Install software prerequisites.

3. Atthe Welcome to the Microsoft SharePoint 2010 Products
Preparation Tool screen, click Next.
4. Acceptthe EULA, and click Next.

5. When the prerequisites finish installing, click Finish.

6. On the main SharePoint installation menu, click Install
SharePoint Server.

7. Enter your product license key, and click Continue.
8. Accept the EULA, and click Continue.
9. Choose the Stand-Alone server type, and click Install.

10. When the installation finishes, check the box for Run the
SharePoint Products Configuration Wizard now, and click
Close.

11. On the Welcome to SharePoint Products screen, click Next.

12. On the pop-up warning about services that will need to be
restarted during the configuration, click Yes.

13. When the wizard has completed the configuration, click Finish.
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Principled analysis, from researching new technologies, to developing new
Technologies® methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the
results to a broad range of target audiences. We provide our clients
Principled Technologies, Inc. with the materials they need, from market-focused data to use in
1007 Slater Road, Suite 300 thei llat 't t | id h test t
Durham, NC, 27703 eir own collateral to custom sa e§ aids, such as test reports,
www.principledtechnologies.com performance assessments, and white papers. Every document reflects

the results of our trusted independent analysis.

We provide customized services that focus on our clients’ individual
requirements. Whether the technology involves hardware, software,
Web sites, or services, we offer the experience, expertise, and tools
to help our clients assess how it will fare against its competition, its
performance, its market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked
together in technology assessment for over 20 years. As journalists,
they published over a thousand articles on a wide array of technology
subjects. They created and led the Ziff-Davis Benchmark Operation,
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CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S
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